
Overview 
WebCMS/Drupal is the primary web platform used by Ohio University. This platform standardizes how 
content is displayed across all University units. Uniformity ensures that all outward and inward facing 
webpages are consistent in branding, voice, typography, and imagery. Visitors to OHIO’s webpages will 
encounter a seamless experience regardless of department or division. 
 

Note: If you are new to WebCMS (or web design in general) peruse Ohio University’s Web Catalog to 

learn the terminology of OHIO’s web components. Having a readily available lexicon of accurate web 

terms will improve communications during the design process. Pages that describe the practical process 

of WebCMS/Drupal web creation can be found within the Website Help Hub. 

Table of contents     
The following table of contents indexes the abstract process of creating new WebCMS pages from 
beginning to end. The technical aspects of building a webpage have already been devised by University 
Communications and Marketing (UCM). CET does not aim to duplicate those efforts, but rather provide 
a supplemental conceptual framework to guide your creative decisions. In some cases, a brief technical 
explanation has been included when specific topics are not covered by UCM.  
 
Links to applicable tutorials are provided throughout the text. 
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Definitions 
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For the sake of clarity, here is a brief glossary of terms: 
  

• Alt text: Alt text is shorthand for alternative text 

• Drupal: The name of OHIO’s content management software; also known as WebCMS 

• Genre: A type of webpage (based on its purpose and scope) 

https://www.ohio.edu/sites/default/files/sites/oit/web/Web-Catalog.pdf
https://www.ohio.edu/ucm/web/help


• Hyperlink: A word or phrase that is stylized in Bold and underlined that links to another page. 

• Landing page: The page that opens when you select a hyperlink.  

• Node: Another word for webpage 

• Parent: A webpage that is at the top of a hierarchy of other webpages 

• Page: Another word for webpage 

• Subpage: A webpage that is below another webpage (or series of webpages) in a hierarchical 

order) 

• TeamDynamix (TDX): A web portal that houses the University’s IT Service Desk, Knowledge Base 

articles, and Service Catalog 

• University Communications and Marketing (UCM): An OHIO organization responsible for all 

news and mass email communications internal and external to the University  

• WebCMS: OHIO’s primary content management software; Also known as Drupal 

• Webpage: A single page that exists within a website 

• Website: A collection of webpages 

Best practices 
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• Style guide: UCM uses the Ohio University Editorial Style Guide which is based on the AP style 

guide (Associated Press). This is the standard for all University communications and webpages. 

The Campus Engagement Team (CET) has also created an amended style guide that provides 

specific guidance not available in the official University style guide.  

• 4-8 grade reading level: Pages should be written between a 4-8 grade reading level. This rule 

should only be violated when a specific communication is exceedingly technical in nature and 

requires advanced diction that cannot be explained in simpler terms. Authors should consider 

the utility of using advanced language and whether it is necessary. Third party software (such as 

the Hemingway App) can assist authors in determining appropriate reading levels. 

• Modular Pages: Use Modular Pages for decorative/user-friendly content. Modular Pages allow 

for additional elements like icons and image cards. See Create Modular Page.  

• Basic Pages: Use Basic Pages for direct content with a simple presentation. Basic pages are great 

for displaying textually based content with limited graphics and unlimited text. 

• Templates: Use templates when beginning the creative design process. Templates help 

structure content. 

• Revision Log: Use the revision Log. Every CMS draft (in edit mode) provides a space for 

describing changes. A simple phrase is adequate – just enough to help publishers quickly identify 

changes. Using the revision log speeds up the publishing process and makes version control 

easier for pages that have repeated edits. 

• University Branding: Use University branding. Drupal automatically formats headings, 

paragraph text, colors, and modules to stay consistent with University branding. However, 

graphic elements (such as rendered images/graphics) should also follow OHIO’s brand 

standards. Please visit OHIO Brand to learn more.  

• Alt Text: Use effective alt text; visit the alt text section below. 

• Hyperlinking: Use effective hyperlinking techniques; visit the hyperlink section below. 

• Accessibility: Keep accessibility in mind; all University websites should be accessible. 

https://www.ohio.edu/ucm/ohio-brand/editorial-style-guide
https://wiki.oit.ohio.edu/display/ITCE/Style+Guide#StyleGuide-UCMstyleguide
https://hemingwayapp.com/
https://www.ohio.edu/ucm/web/help/add-new-content/create-modular-page
https://www.ohio.edu/ucm/web/help/add-new-content/create-basic-page
https://www.ohio.edu/ucm/web/help/all-templates
https://www.ohio.edu/ucm/ohio-brand/


Determine the scope of the page (Page genres) 
Back to top 

Make sure the scope of your page is appropriate for WebCMS! 

There are many different page genres that serve a variety of purposes. Most page genres will fall under 

the purview of the WebCMS platform and are managed directly by OIT. Other page types are built 

within WebCMS but are managed by other groups at the University. All other webpage genres are not 

built within WebCMS, but within parallel web platforms such as TDX.  

The following list will explain the different genres, and when and where they are most appropriately 

applied: 

Page Genre Description Platform(s) Managed 
by? 

Example Notes 

Educational Educates visitors on University 
resources, services, programs, 
initiatives, and research findings. This 
genre can be multi-purpose, existing 
simultaneously with other genres on a 
single page. 

WebCMS all OHIO IT Governance  

Organizational/struc
ture 

Sometimes webpages are ordered 
hierarchically to resemble the 
organizations they represent. 
 
For example: within OHIO Treasury 
Operations are several sub-
departments such as budgeting, 
accounting, and Purchasing. The page 
is organized hierarchically (via the top 
menu), which resembles the hierarchy 
of the organization.    

WebCMS all OHIO Treasury 
Operations 

Should only be built 
when an 
organizational 
hierarchy of 
webpages already 
exists (unless the 
page is part of a 
larger 
reorganizational 
effort). 

Policy/standards Basic pages that outline a specific 
policy or procedure. 

WebCMS all OHIO IT Security 
Standards 

 

Biographies Individuals at the University may 
require their biographical information 
(in addition to a picture) to be 
presented on a single webpage. 

WebCMS all OHIO Candace J. 
Boeninger 

 

University initiatives Broad over-arching pages outlining 
major University projects.  

WebCMS all OHIO Major IT 
Initiatives 

 

Events Major campaigns or social initiatives 
will occasionally warrant their own 
event webpage. 

CUE, 
occasionally 
WebCMS 
 

all OHIO 2023 Martin 
Luther King, Jr. 
Celebration 

Most events should 
be posted via the 
CUE calendar 

Group pages Groups that are either officially or 
unofficially affiliated with University 
organizations, divisions, departments, 
and/or colleges, etc. 

WebCMS All OHIO The IT 
Advisory 
Community: 
Teaching and 
Leaning 
Technologies 
webpage 

 

How-to/tutorials Managed within the Knowledge Base 
and Confluence wiki 

TeamDynamix, 
Confluence 

OIT Enrolling in 
Microsoft 
Azure MFA 
 
Processing 
CET Intake 
Requests 

Pages describing 
technology use, 
software, hardware, 
and applications are 
housed within the 
Knowledge Base. 
 
Pages that describe 
internal procedures 

https://www.ohio.edu/oit/governance
https://www.ohio.edu/finance/treasury
https://www.ohio.edu/finance/treasury
https://www.ohio.edu/oit/security/policy-and-practices/consulting/standards?check_logged_in=1
https://www.ohio.edu/oit/security/policy-and-practices/consulting/standards?check_logged_in=1
https://www.ohio.edu/enrollment-management/leadership-team/boeningc
https://www.ohio.edu/enrollment-management/leadership-team/boeningc
https://www.ohio.edu/oit/initiatives
https://www.ohio.edu/oit/initiatives
https://www.ohio.edu/diversity/dr-mlk-jr-celebration
https://www.ohio.edu/diversity/dr-mlk-jr-celebration
https://www.ohio.edu/diversity/dr-mlk-jr-celebration
https://calendar.ohio.edu/calendar
https://www.ohio.edu/oit/governance/advisory-communities/teaching-learning
https://www.ohio.edu/oit/governance/advisory-communities/teaching-learning
https://www.ohio.edu/oit/governance/advisory-communities/teaching-learning
https://www.ohio.edu/oit/governance/advisory-communities/teaching-learning
https://www.ohio.edu/oit/governance/advisory-communities/teaching-learning
https://www.ohio.edu/oit/governance/advisory-communities/teaching-learning
https://www.ohio.edu/oit/governance/advisory-communities/teaching-learning
https://help.ohio.edu/TDClient/30/Portal/KB/
https://wiki.oit.ohio.edu/#all-updates
https://help.ohio.edu/TDClient/30/Portal/KB/ArticleDet?ID=265
https://help.ohio.edu/TDClient/30/Portal/KB/ArticleDet?ID=265
https://help.ohio.edu/TDClient/30/Portal/KB/ArticleDet?ID=265
https://wiki.oit.ohio.edu/display/ITCE/Processing+CET+Intake+requests
https://wiki.oit.ohio.edu/display/ITCE/Processing+CET+Intake+requests
https://wiki.oit.ohio.edu/display/ITCE/Processing+CET+Intake+requests
https://help.ohio.edu/TDClient/30/Portal/KB/


and processes 
(used by Campus 
Engagement) are 
stored in the 
Confluence wiki.  
 

Hardware/Software 
descriptions 

Exclusively maintained within the 
Knowledge Base 

TeamDynamix OIT Understandin
g Supported 
Software 

These pages are 
owned by groups 
comprised of Tier 2 
subject matter 
experts. 

Procedural CET internal procedures that outline 
workflows and processes 

Confluence OIT Article 
deadlines 

 

Service Offerings Includes information on services, 
accessibility, security information 
specific to each offering. 
 

TeamDynamix OIT Service 
Catalog 

Service Owner 
responsibility 
groups can edit 
Service Catalog 
pages.  

News pages All news pages are published via 
submission to OHIO News. 

WebCMS UCM OHIO News 
stories 

 

 

Note: If you are not sure who owns specific WebCMS or TDX content please visit the WebCMS content 

ownership page to learn more. 

Note: Reference the Knowledge Management Process Documentation for instructions on creating, 
revising, and publishing knowledge base articles. 

Determine your audience. Who is going to visit the page? 
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The orientation of the page should determine how the information will be organized. 

• External groups (outward facing page). Content should be displayed in a manner that is 

attractive, logical, intuitive, and easy to navigate and understand. Externally facing pages use 

more decorative elements, such as the hero Image, graphics, infographics, and photography. 

Modules provide an attractive aesthetic that lends to these qualities. These types of pages will 

require more time and consideration in the drafting process. Audience groups may include: 

o Students 

o Faculty 

o Non-OIT staff 

o Parents 

o Community members 

• Note: Use the Personas to guide your communications. A robust listing of student personas has 

been developed to guide content creators. Follow the guidelines on the student personas page to 

determine which personas to include when communicating with student audiences. 

 

• Internal groups (inward facing page). Though content on internally facing pages should also be 

displayed in a manner that is logical, intuitive, and easy to navigate and understand, decorative 

elements are not as important. Attractive eye-catching design can be used for internally facing 

audiences, but does a robust design concept pay an adequate return on investment? Audience 

groups may include: 

https://wiki.oit.ohio.edu/#all-updates
https://wiki.oit.ohio.edu/#all-updates
https://help.ohio.edu/TDClient/30/Portal/KB/
https://help.ohio.edu/TDClient/30/Portal/KB/ArticleDet?ID=532
https://help.ohio.edu/TDClient/30/Portal/KB/ArticleDet?ID=532
https://help.ohio.edu/TDClient/30/Portal/KB/ArticleDet?ID=532
https://wiki.oit.ohio.edu/display/ITCE/Article+and+Communication+Deadlines
https://wiki.oit.ohio.edu/display/ITCE/Article+and+Communication+Deadlines
https://help.ohio.edu/TDClient/30/Portal/Requests/ServiceCatalog
https://help.ohio.edu/TDClient/30/Portal/Requests/ServiceCatalog
mailto:news@ohio.edu?subject=A%20new%20article%20submission
https://www.ohio.edu/news/all-stories
https://www.ohio.edu/news/all-stories
https://wiki.oit.ohio.edu/display/ITCE/OIT+Website+Access+List%2C+Publishing+Process%2C+and+Responsibilities
https://wiki.oit.ohio.edu/display/ITCE/OIT+Website+Access+List%2C+Publishing+Process%2C+and+Responsibilities
https://catmailohio.sharepoint.com/:b:/s/OIT-ITDownloads/Ec1LZd2kV5ZGk0UzhlvdDlUBUAlmJyNkSPJxblC_7BmT6Q?e=diYE2b
https://wiki.oit.ohio.edu/display/ITCE/Personas


o OIT staff 

o Administrators 

o Faculty 

New page creation (requirements) 
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Visit UCM’s Website Help Hub to learn more about Adding New Content. 

• New original pages: In most situations, the need for a new webpage is initially determined by 

Service groups and CET working collaboratively. Service groups will work in conjunction with 

their Campus Engagement Specialist (CES) liaisons to draft the original page concept. Once a 

page has passed the initial review, a CES will draft the page in WebCMS. New web page requests 

can also be submitted via the CET Intake form. 

 

Development stages: 

o A resource manager, service owner, or CET member identifies the need for a new 

webpage.  

o The campus engagement team verifies the need for a new webpage.  

o The CET member works with the requestor to create a draft. 

o The requestor approves. 

o The CET member follows the normal publishing process (see the WebCMS Publishing 

process).  

o A second CET member reviews and publishes.  

o The CET member is responsible for communicating the changes to anyone necessary 

(like, an IT weekly article, highlighting it in an OHIO IT updates meeting, etc.,). 

   

• Document migrations: These are similar to new original pages, except the content already exists 

in either PDF format or old webpage documentation (see the new page creation process). PDFs 

are currently not considered accessible.  

o Some document migrations are simply copying and pasting text. Other projects may 

require reinterpretation. This determination is at the discretion of the party responsible 

for the work. 

• New original content vs. linking a vendor page: The University possesses a substantial body of 

help and how-to articles. Sometimes good documentation already exists – and can be linked to.  

A general rule: 

• Link to vendor page when: 
o The vendor's help content is extensive, useful, and applicable. 
o OHIO users' experience is similar or identical to what is explained on the vendor 

page (e.g., screenshots on the vendor page match OHIO users' experience). 

• Create (and maintain) help content when: 
o The vendor's help content for that topic doesn't exist. 
o The vendor's help content for that topic is confusing or not useful. 

https://www.ohio.edu/ucm/web/help/add-new-content/create-basic-page
https://forms.office.com/Pages/ResponsePage.aspx?id=B4Aw83xHcEqIiTRhGBfFWuWK0D6KQdFLiqkU5vsUehxUOVA2SjNUNkdOMzc3RU5HVlcyMEVTTDM1QiQlQCN0PWcu


o The tool in question is configured in such a way that OHIO users' experience is 
markedly different from what is shown in the vendor help article. 

Adding text to your page (and design considerations) 
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Text for new pages should be carefully planned in a Microsoft Word document or other word processor 
before being migrated into the WebCMS text editor. It’s also a good idea to write your initial webpage 
draft in unformatted text, since formatting conventions such as headings, bullets, and numbering are 
often lost in translation from one program to the next. Word processors typically use sophisticated 
spelling and grammar checkers, which can help you discover mistakes before migrating to the WebCMS 
editor.  
 
Start out with a basic draft with minimal formatting. Some page types and modules allow for unlimited 
text. Other modules only allow a certain word count. Therefore, knowing your page’s overall design 
(before drafting content) will set the parameters for how much text will be allowed. Conversely, if your 
new page is expected to be “text heavy” then selecting a module that accommodates this style should 
be decided early in the design process.     

Hyperlinking text 
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Hyperlinking is especially useful when there is additional information available but may be slightly off-
topic from the content of the webpage. Hyperlinks also allow authors to expound nuanced topics. Since 
hyperlinks typically contrast with normal paragraph text (in WebCMS the typeface is bolded and colored 
Cutler Green) readers can skim a text and easily find relevant external content. 
 
If you require assistance on how to hyperlink in Web CMS, UCM has provided a robust collection of self-
guided tutorials on the topic of hyperlinking. Visit Managing Links to learn how to hyperlink.  

 

Hyperlink text should have these attributes: 
• Short and concise, preferably a phrase of no more than 3-5 words. 

• Be a call to action. Instruct the viewer on their next steps. 

• Give context to the landing page indicated. 

• If linking to a file Include the file type (e.g., PDF, PPTX, etc.,) at the end of the link text. 

• Use the title of the landing page (if it matches the criteria in this bullet list). 

Warning: Avoid hyperlinking entire sentences. Look for the action words in the text that indicate more 

information. 

Here is an example of text that has been hyperlinked correctly: 

“If you or your students have questions or concerns, please contact the IT Service Desk or visit Getting 

Started with Inclusive Access for more information.” 

https://www.ohio.edu/ucm/web/help/links
https://nam11.safelinks.protection.outlook.com/?url=https%3A%2F%2Ft.e2ma.net%2Fclick%2F3rddbz%2F3zbp9scb%2F7uq448g&data=05%7C01%7Cdills%40ohio.edu%7Caddf939a53914f33c1f208db42a18ac2%7Cf3308007477c4a70888934611817c55a%7C0%7C0%7C638177033808054496%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000%7C%7C%7C&sdata=skz2hIE42KEghY82so095CHA5%2BXTPH6JeET%2B4sGqubo%3D&reserved=0
https://help.ohio.edu/TDClient/30/Portal/KB/ArticleDet?ID=347
https://help.ohio.edu/TDClient/30/Portal/KB/ArticleDet?ID=347


Also consider whether a link could be emphasized by using Modular Page elements like a call to action 

button, image tile, icon tile, icon group, card link, or topic preview – see our Web Element Catalog to 

review your options. Buttons can be stylized in the text editor. 

Note: WebCMS provides direct node linking to other WebCMS pages. When linking to other WebCMS 

pages, be careful to use the externally facing URL. Externally facing URLs begin with www.ohio.edu/oit. 

Drupal/WebCMS internal links begin with www.webcms.ohio.edu/. The latter is used internally by web 

editors and cannot be seen by outside users. If used, page visitors will encounter a 404 Error (or similar 

message). Visit Managing links to learn more. 

More Information: To learn more about creating useful hyperlink text, check out this guide for writing 
effective hyperlinks from the Nielsen Norman Group. 

How to upload files to IT Downloads (for hyperlinking) 
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When linking to a file is necessary, do the following: 
1. Upload the file into the appropriate subfolder of the IT Downloads Group. When opened, the 

subfolders are available in the left navigation menu. If you do not have access to the group, post 
a request to be added in the OIT Website channel on Teams. 

2. Select the ellipses to the right of the file name. 
3. In the menu, select Share.  

a. Select People you specify can view under the copy link heading.  
b. A new menu will open. 
c. Select People in Ohio University.  
d. Make sure that Can view is selected under More settings. 

 
4. Select Apply. 
5. A new link box will appear. 
6. Select Copy to copy the Link. 
7. Use the copied link in Web CMS. Include the file type (e.g., PDF, PPTX, etc.,) at the end of the link 

text. 
8. To test the link, open the link in an Incognito or Private Browsing window to see if it asks for login 

credentials. 
 

Updating or Moving Files 
• Updating a file: There are two ways to update a file while preserving existing links to that file: 

1. Edit the file in place using the appropriate Office 365 tool - works with MS formats like 
DOCX, PPTX, XLSX that have a corresponding Office 365 app. 

2. Overwrite the existing file with a new uploaded version of the same name - works for all 
formats. If you choose this method, make sure the name of your new file matches the 
old one exactly. 

• Moving a file: If you move a file within IT Downloads, make sure to verify that your Web CMS 
link to the page still works.  

 

How to add images/videos 
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https://www.ohio.edu/ucm/web/web-catalog
http://www.ohio.edu/oit
http://www.webcms.ohio.edu/
https://www.ohio.edu/ucm/web/help/links
https://nam11.safelinks.protection.outlook.com/?url=https%3A%2F%2Ft.e2ma.net%2Fclick%2Ff1g77y%2Fvd56ixl%2Fjsgov8g&data=05%7C01%7Cwuit%40ohio.edu%7C5f41165282fc4f8ed85308db2ca26c81%7Cf3308007477c4a70888934611817c55a%7C0%7C0%7C638152848353116013%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000%7C%7C%7C&sdata=kh9ZVtVw%2FzftDrOl1v9YtFhweyyCOLrs7NjzJW4vgBI%3D&reserved=0
https://nam11.safelinks.protection.outlook.com/?url=https%3A%2F%2Ft.e2ma.net%2Fclick%2Ff1g77y%2Fvd56ixl%2Fjsgov8g&data=05%7C01%7Cwuit%40ohio.edu%7C5f41165282fc4f8ed85308db2ca26c81%7Cf3308007477c4a70888934611817c55a%7C0%7C0%7C638152848353116013%7CUnknown%7CTWFpbGZsb3d8eyJWIjoiMC4wLjAwMDAiLCJQIjoiV2luMzIiLCJBTiI6Ik1haWwiLCJXVCI6Mn0%3D%7C3000%7C%7C%7C&sdata=kh9ZVtVw%2FzftDrOl1v9YtFhweyyCOLrs7NjzJW4vgBI%3D&reserved=0
https://catmailohio.sharepoint.com/sites/OIT-ITDownloads
https://teams.microsoft.com/l/channel/19%3a94d9107d13e742d48e732ed74773ecb9%40thread.skype/OIT%2520Website?groupId=fd3d2e82-d0c5-4c91-87e3-dc1d4cedbd5a&tenantId=f3308007-477c-4a70-8889-34611817c55a


 
Images are great for providing interest, context, color, and creativity to your webpages. 
 
UCM has provided an exhaustive series of pages dedicated to Using Images on the Website. Please 
explore these pages for more information on OHIO’s best practices: embedding images and videos; 
editing images; how to find images in Photoshelter; and the use of Hero images. 
 

Using images already stored in WebCMS 
Images that have been previously uploaded into WebCMS are available for reuse. Images can either be 
marked as published or unpublished. 
 

1. Select the insert image function in the WebCMS editor, a dialog box will open. 
2. In the top lefthand corner of the window select All media. 
3. Select Published or Unpublished. 
4. Provider: is optional. 
5. Media Name: If you know the name of the media you are looking for you can enter it here.  
6. Language: is optional. 
7. Select the image you want. It will be marked with a green checkmark (you can only select one 

image at a time). 
8. Scroll to the bottom of the dialog box. 
9. Select the Select Media button.  
10. At the bottom of the dialog box, the editor provides additional steps for image style, 

hyperlinking, alignment, and captioning. These settings are available depending on your 
specific needs.  

 
How to add images to the OIT group 
WebCMS allows grouping of images within its database. OIT has its own image group. 

1. Select the Insert image function in the editor, a dialog box will open. 
2. In the top lefthand corner of the window select Add new image. 
3. Give a name to the image. Make sure the name is descriptive enough so it will be easily 

distinguishable (in a list) from similar images. 
4. Choose the file. This allows you to upload an image from your device (there is a 2 MB limit to 

file size). 
5. Give the image some alternative text. See the section on providing how to use alt text. 
6. Crop/Edit the image as needed. 
7. Mark the image as published if you will be publishing immediately. Mark as unpublished if you 

are collecting images in a group to use later. 
8. In the Group box type “OIT.” This will add the image to the OIT group. 
9. Select Save image. 
10. At the bottom of the dialog box, the editor provides additional steps for image style, 

hyperlinking, alignment, and captioning. These settings are available depending on your 
specific needs.  

How to use alt text 
Back to top 
 

Alt text fields are available for both images and hyperlink text in WebCMS.  

https://www.ohio.edu/ucm/web/help/images
https://www.ohio.edu/ucm/web/help/photoshelter
https://www.ohio.edu/ucm/web/web-catalog/hero-image


Alt text can be used in many different forms and contexts. It can describe what is happening in a picture, 
explain why a link is relevant, or create a summary of information in a graph. It is also indexed by search 
engines, displayed in search result snippets, and used in the absence of an image (when an image 
doesn’t load). 
 
Screen readers use alt text to aid those who may be visually impaired. These devices organize 
information on a page audibly, so that visitors can decide which information is most relevant to them. 
Headings provide auditory benchmarks, and alt text differentiates images, graphics, and links so that 
users can quickly select items they are most interested in. 
 
Please visit the section titled Image Descriptions and Alternative Text on UCM’s page Universal 

Techniques for Digital Accessibility to learn more about creating effective Alt Text.   

Things to avoid when using alt text: 
• Do not use phrases such as “This is an image of…” or “This is a picture of…” when creating alt 

text. Screen readers automatically announce the presence of an image, therefore making this 

information redundant. Screen readers will read all information on a page and are unable to 

differentiate important vs. unimportant items.  

• Do not use similar language for each alt text on a page. Each item should be uniquely discernible 

so that the user knows exactly what is being viewed. 

Good practices when using alt text: 
• Should be concise and to the point. 

• Should adequately describe the image, graphic, or landing page. 

• Should be relevant to the surrounding text. 

• If there is text on an image, please consider the following: 

o If the image is decorative in design (and does not provide additional context to the 

words within the image) the alt text should copy that text verbatim.  

o If the image provides additional context to the text within the image, alt text should 

summarize both the text and contextual elements.  

o If there is too much textual information to list, the alt text should convey the summary 

meaning of the image. 

 

 

 

Some alt text examples 
Using the following image: 

https://www.ohio.edu/oit/accessibility/guidelines/universal-techniques
https://www.ohio.edu/oit/accessibility/guidelines/universal-techniques


 

• Image alt text: should adequately describe the context of an image. It should also be relevant to 

the surrounding text. Here are three examples: 

o BAD: “A picture of a building and the sun.” This alt text provides zero context for the 

picture and uses the phrase “A picture of.”   

o BETTER: “A blinding sun sends golden rays, reflecting off blades of emerald grass in the 

Athens campus College Green, under a clear spring sky.” While this alt text provides 

plenty of context, it’s a little too wordy.        

o GOOD: A new spring sun shines brightly through Athens’ campus trees. While this 

description doesn’t describe the entire picture – it provides enough context to give a 

mental image. 

o Note: Remember the adage “A picture is worth a thousand words.” A picture can provide 

multiple contexts. Be sure to describe the context that best suits the surrounding text. 

• Hyperlink Title text: should adequately describe the landing page or website that the text is 

linked to. While hyperlink Titles do not exhibit the same behaviors as “alt text” it does provide 

information when “hovering” over a link with a mouse. Hyperlink Titles should always be used 

for videos. 

o BAD: The alt text matches the hyperlink text in the current page verbatim. 

o BETTER: The alt text is the title of the page. 

o GOOD: The alt text describes the purpose of the landing page and why it is useful to the 

visitor. 

• Chart or infographic alt text: should describe the most obvious conclusions that can be drawn 

from the visual aid, while simultaneously providing additional insight.  



 
o BAD: “This is an infographic about dogs.” 

o BETTER: “A circular infographic that demonstrates the historical breeding of 

Bloodhounds, German Shepherds, Bulldogs, Cocker Spaniels, and many more!” 

o GOOD: “A circular infographic demonstrating the historical breeding of modern 

domestic and wild dog breeds.”   

 

Adding alt text to hyperlinks (the technical application in Drupal) 
This section is additional information that may not be available in UCM’s normal tutorials/help guides. 

The following is a practical explanation of how alt text is described by Drupal in certain instances.  

 

When adding hyperlinks to a page, a dialog box will open to allow you to link the URL of the destination 

page. In WebCMS, the alt text for hyperlinks is called the Title. 

 

 
 



Adding alt text to images 
When adding images to a page, a dialog box will open. In WebCMS the alt text for images is called by its 

full name Alternate text. 

 

 

Editing menus 
Back to top 

 

When editing menus, remember that any changes you make will be visible immediately after saving. 

There is no "Needs Review" status for a menu entry. 

Our site's top and left navigation menus can be found in the View tab of the Web CMS editor/publisher 

interface.(You must have WebCMS access to view these links). 

• Log in to https://webcms.ohio.edu/web-login 

• Select OIT in the main body of the landing page. 

• Go to the View tab. 

• The menu structure is represented vertically under the heading Menu Permissions. 

Our Menu Structure 
The Menu Permissions include both the top and left navigation menus on the OIT primary home page, 

as well as major OIT subgroupings such as security and accessibility, etc. 

https://webcms.ohio.edu/groups/oit
https://webcms.ohio.edu/user/dills
https://webcms.ohio.edu/user/dills
https://webcms.ohio.edu/web-login


 

Top Menu 
The Top menu controls what customers see in our top navigation bar. Top menu items should be 

reserved for the most important categories of information. These categories are at the top of a large 

hierarchy of webpages.    

• Example: this is the OIT home page Top Menu. Within the WebCMS editor it is labled as: /oit/ 

Top.  

 

Left Menus 
The left menus control what customers see on the left side of a browser. Mobile devices use a 

“hamburger” drop down menu. Left menus can have up to three levels. 

• Example: this is the OIT home page Left Menu. Within the WebCMS editor it is labled as: 

/oit/security/ | Left 

 

• When published, the left navigation menu will exhibit these behaviors: 

o Nav items with no subpages: Will function like a link. There will be no name next to the 

Arrow. 

o Left nav item with one or more levels of subpages: Viewers can select this item to 

reveal/hide a list of subpages. Its name will have an arrow to let customers know it is 

expandable. 



 

Menu item naming 
• Keep names short but clear: In most cases, you should use a shorter version of the linked page's 

full title. 

• Avoid redundancy in nested menus: Don't repeat the service name in front of every submenu 

item. 

Creating or editing menu items 
1. Within the View tab, navigate to the appropriate menu entry (such as /oit/security/ | Left). 

2. To create a menu item, choose Add Link. To edit, choose Edit next to the item you wish to 

modify. 

3. Complete the fields as follows: 

o Menu link title: This is the text that visitors will see. 

o Link: The URL for the menu item. 

▪ For WebCMS-hosted links, start typing the name of the page and select it from 

the list of nodes (e.g., Get Help [50346]).  

▪ External URLs should be entered manually, including the entire path. 

o Enabled: Uncheck this box when creating a new item. Doing so gives you a chance to 

verify that everything looks correct before the item becomes available to customers. 

o Description: This text will display as a tool tip if a visitor hovers over the menu item 

without selecting. 

o Show as expanded: This option should remain unchecked. 

o Parent link: If the new page belongs underneath an existing menu item, select the 

parent page here. Do not go more than three levels deep. 

o Weight: This item can be left at zero. 

4. Select Save. 

Changing the location of a menu item 
1. Within the edit menu page, place the cursor over the crossed arrows icon and hold the left enter 

key on your mouse. This will allow you to “grab” the Menu Link. 

2. Move the menu link to the desired position within the hierarchy. 

 

Note: dragging can affect both vertical position and parent/subpage relationships. 

Parent/subpage relationships are identified via indents. When moving an item, verify that it is in 

the correct position, and indented appropriately. 

 

WebCMS does not prevent you from adding more than three menu layers, however it will only 

publish three. If you add a fourth layer, it may cause the webpage to behave incorrectly. 



 

 

After moving the menu item: 

1. Make sure the Enabled check box is selected next to the item. 
2. Scroll to the bottom of the page. 
3. Select Save. 

Note: If you select an Edit button before saving, any previous changes you made will be lost.  

Enabling/Disabling an existing menu item 

1. Within the View tab, navigate to the appropriate menu entry. 
2. Check/uncheck the Enabled to make menu items visible (or invisible) to customers. 
3. Scroll to the bottom of the page. 
4. Select Save. 

Accessibility 
Back to top 

 
Our Digital Accessibility Guidelines say it best: 
 
“OIT is committed to supporting universal access to Information and Communication Technology (ICT) at 
Ohio University. Improving accessibility makes technologies like websites, apps, software, documents, 
and videos easier for everyone to use, including people with disabilities.” 
 
Since we are ethically and legally responsible for adhering to accessibility and usability principles, editors 
and publishers should become familiar with our guidelines linked above.  

 

A few accessibility reminders: 

• Avoid using images without context: If you upload an image of a complex diagram, it will be 
functionally invisible to some users. Always generate useful alt text. If the image contains 
essential information, make sure that information is also described in the page's main text. 

https://www.ohio.edu/oit/accessibility/guidelines


o Optimize pages for visitors who scan: Sighted users scan webpages to look for relevant 
content. Screen-readers also scan content. Accommodate this behavior by:Using 
bulleted lists and short paragraphs. A wall of text can prevent users from reading. Break 
up text so it's easier to scan. 

• Use descriptive links: Ensure that your link text is meaningful. Carefully select hyperlink text.  
• Avoid spatial verbiage: Words like above, below, to the left, on the right seem intuitive, but can 

be confusing for some page visitors. The webpage layout will reorganize on different devices 
(i.e., mobile vs. tablet vs. desktop, etc.,). Spatial terms will become meaningless in some 
instances. Phrases like “Select the button above” will not have meaning to someone using 
assistive technology.  

• Use globalized language: Make sure to use simple words with precise meanings. Avoid 
homonyms with multiple definitions.  

o Example: Use “select” rather than the word “click.” Click is also an auditory sound and 
may be confusing for international users who may be unfamiliar with its colloquial 
usage.  

• Use Headings: The text box in WebCMS allows you to select specific styles of headers. Do not 
use boldface to highlight headers. Your page outline is used by search engines and assistive 
technologies like screen readers to give the user, or the search engine, a better way of 
navigating through relevant text. Proper headings allow all viewers to easily "skim" a page for 
the content relevant to them. Use page headings frequently. 

• Use descending headings: Headings are classified as H1, H2, H3, H4 etc. H1 is the largest 
typeface. Higher numbers (such as H4) are sequentially smaller typeface. Larger headings 
denote broader topics, smaller headings are for subtopics.  

 
Reviewing and publishing process 

Back to top  
 
This section describes additional processes required by CET, in addition to the technical process of drafting, 
editing, and publishing pages. The following procedures ensure a consistent reviewing and publication 
process.     
 
If you require assistance using the WebCMS tools, step-by-step tutorials and instructions can be found by 
visiting UCM’s Website Help Hub. Web editors, managers, and publishers should carefully explore UCM’s 
resources, and become familiar with WebCMS’s full capabilities.  
 
UCM also provides a monthly Web Editors forum. All persons creating and editing webpages on 
www.ohio.edu/oit are strongly urged to utilize these resources.  

 

Making changes to an existing WebCMS page 
1. Visit UCM’s Website Help Hub subpage Edit and Publish to learn the step-by-step process of editing 

and publishing a page in WebCMS.  
2. Once changes have been made, document your changes in the Revision Log. The revision log is a 

small text field in the upper righthand corner of the editor. Type a brief explanation here that briefly 
describes what has been changed on the webpage. 

3. Save the draft as Needs Review (do not publish without first seeking a peer review). 

https://www.nngroup.com/articles/f-shaped-pattern-reading-web-content/
https://www.ohio.edu/oit/accessibility/guidelines/universal-techniques#headers
https://www.ohio.edu/ucm/web/help/edit-and-publish
https://teams.microsoft.com/l/channel/19%3aeD7gZMuzExxmkbe5dOX0Xd2tXsovUzLdK7DVo1WyXJw1%40thread.tacv2/General?groupId=1fba625c-c9d1-40b7-bc22-19c8b3f97a1b&tenantId=f3308007-477c-4a70-8889-34611817c55a
http://www.ohio.edu/oit
https://www.ohio.edu/ucm/web/help/edit-and-publish


4. Post a new conversation in the OIT Website channel asking for review. Approvers will follow the 
procedure outlined in the next section titled Responding to a Review Request: Publishers. The post 
should include:  

1. @mention the OIT Website channel. 
2. @mention a specific publisher (optional). 
3. State the expected timeline/urgency of publishing. 
4. Include the link to the “Latest Revision.” 
5. A brief synopsis of what has changed 
6. @mention/CC: any impacted colleagues or service teams for awareness. 

 

 
 

Note: To make your editor’s life easier, please include the latest revision of the webpage. A link to the 
latest revision can be found at the bottom of the newly drafted page (after saving a page as a draft). The 
latest version URL will look similar to this: https://webcms.ohio.edu/node/159376/latest. The word 
“latest” will always be at the end of the URL. 
 

Responding to a Review Request: Publishers 
1. Monitor the OIT Website channel in Teams.  
2. When someone posts a request for review, reply to that thread with the word “Reviewing” in 

the comments. This should prevent multiple people reviewing the same item simultaneously.  
3. Follow these steps to complete the review: 

a. Select the provided URL to visit the latest version of the page. If the latest version has 
not been provided in the request, you can visit the node via your profile in WebCMS. 
WebCMS editors should also receive an email stating recent changes such as below: 
 

 
 

https://teams.microsoft.com/l/channel/19%3a94d9107d13e742d48e732ed74773ecb9%40thread.skype/OIT%2520Website?groupId=fd3d2e82-d0c5-4c91-87e3-dc1d4cedbd5a&tenantId=f3308007-477c-4a70-8889-34611817c55a
https://teams.microsoft.com/l/channel/19%3a94d9107d13e742d48e732ed74773ecb9%40thread.skype/OIT%2520Website?groupId=fd3d2e82-d0c5-4c91-87e3-dc1d4cedbd5a&tenantId=f3308007-477c-4a70-8889-34611817c55a
https://webcms.ohio.edu/node/159376/latest
https://teams.microsoft.com/l/channel/19%3a94d9107d13e742d48e732ed74773ecb9%40thread.skype/OIT%2520Website?groupId=fd3d2e82-d0c5-4c91-87e3-dc1d4cedbd5a&tenantId=f3308007-477c-4a70-8889-34611817c55a


b. Once the page is open, scroll to the bottom of the page. A list of menu items should be 
present in this order at the bottom of the page: View, Edit, Latest version, Delete, 
Revisions, and Clone.  

c. Select Revisions. This will take you to a listing of all revisions past and present for the 
current page. Each revision should have a brief sentence or two under the node version 
title, explaining what was changed in that revision. 

d. Select the radio buttons to compare the changes between two different versions.  
• The first column of radio buttons falls under the category Compare this… 
• The second column falls under the category…with this. 
• Select one level of revision in each column to compare.  

e. After selecting two levels of revision scroll down to the bottom of the page and select 
the Compare selected revisions button. 

• Once the comparison page loads, additions will appear in green; deletions will 
appear in pink strikethroughs. (These colors will disappear when you publish). 

f. Select the browser’s back button to take you back to the revisions page.   
 

 
 

Edit after reviewing the latest version 
At the top of the page are a row of menu items: View, Edit, Latest version, Delete, Revisions, Clone. 

1. Choose the Edit tab and do one of the following. You will need to scroll to the bottom right of 
the page to see the publishing options.  

• Publish page as-is: Set the dropdown from Needs Review to Published and click Save. 
You do not need to fill out a revision log. 

• Publish page with additional edits: If you revised anything as part of the review process, 
note those changes in the Revision Log before setting the dropdown to Published and 
clicking Save. 

• Send page back to editor for revisions: If the page requires extensive changes, set the 
dropdown from Needs Review to Draft and click Save. 

2. Reply to the original Teams thread with one of the following: 
a. Published. Include any other applicable information (e.g., "I made a few wording 

changes" or "I fixed a broken link"). 
b. An explanation that the page needs additional edits before it can be published. 

 

Self-Publishing 
Under normal circumstances, publishers should avoid approving their own changes; however, there are two 
situations where it's ok to self-publish.  
 



Emergency Updates 
If something is broken on our site, it's okay to fix the problem immediately without following the normal 
approval process. Examples include bad links, inaccurate content, and typos reported by customers. 
 
When fixing an issue like this, you should always: 

1. Include a note in the Revision Log that explains why you chose to self-publish. 

2. Create a thread in the OIT Website channel in Teams to let CET know about your changes. 

 

When CET peer reviewers are not available 
If another CET publisher is not available to approve changes, it is acceptable to set the status 
from Draft to Published (with the proviso that a relevant colleague, subject matter expert, IT website 
Editor, etc.,) checks your work before publishing. This method is not preferred and should be avoided 
when possible.   
 

When you perform an in-person review: 
1. Include a note in the Revision Log that indicates who approved the content. 

2. Create a thread in the OIT Website channel in Teams to let CET know about your changes. 
 

When random errors are discovered 
If you find an error somewhere on the OIT Website (broken link, typo, etc.) please follow these steps: 

1. Post a new conversation in the OIT Website channel alerting the Campus Engagement team to the 
error. Be sure to @mention the channel so followers get notified. 

• Example: "@OIT Website - It appears that the _____ link on the _______ page is broken." 
2. A member of the Campus Engagement team will work to identify an SME who owns the page, ask 

the SME for relevant information, and then correct the error. 
3. If the change requires awareness, please @mention any impacted colleagues or service teams. 

Resources 
Back to top 
 

Join the Web Matters newsletter to learn all of the tips and tricks for website management.  
Learn more about Web Policies from University Communications and Marketing. 
 
The Knowledge Management Process outlines how new articles are created and managed within the 
Knowledge Base. 
 
UCM also provides a monthly Web Editors forum. All persons creating and editing webpages on 
www.ohio.edu/oit are strongly urged to utilize these resources.  

Further reading 
Back to top  

https://teams.microsoft.com/l/channel/19%3a94d9107d13e742d48e732ed74773ecb9%40thread.skype/OIT%2520Website?groupId=fd3d2e82-d0c5-4c91-87e3-dc1d4cedbd5a&tenantId=f3308007-477c-4a70-8889-34611817c55a
https://teams.microsoft.com/l/channel/19%3a94d9107d13e742d48e732ed74773ecb9%40thread.skype/OIT%2520Website?groupId=fd3d2e82-d0c5-4c91-87e3-dc1d4cedbd5a&tenantId=f3308007-477c-4a70-8889-34611817c55a
https://www.ohio.edu/oit
https://teams.microsoft.com/l/channel/19%3a94d9107d13e742d48e732ed74773ecb9%40thread.skype/OIT%2520Website?groupId=fd3d2e82-d0c5-4c91-87e3-dc1d4cedbd5a&tenantId=f3308007-477c-4a70-8889-34611817c55a
https://signup.e2ma.net/signup/1941552/1929680/?utm_source=newsletter&utm_medium=email&utm_content=Sign%20up&utm_campaign=web-matters_041423_UCM
https://www.ohio.edu/ucm/web/web-policies?utm_source=newsletter&utm_medium=email&utm_content=web%20policies&utm_campaign=web-matters_041423_UCM
https://catmailohio.sharepoint.com/sites/OIT-ITDownloads/TeamDynamix/Forms/AllItems.aspx?id=%2Fsites%2FOIT%2DITDownloads%2FTeamDynamix%2FKnowledge%20Management%20Process%20Documentation%20%281%29%2Epdf&parent=%2Fsites%2FOIT%2DITDownloads%2FTeamDynamix
https://teams.microsoft.com/l/channel/19%3aeD7gZMuzExxmkbe5dOX0Xd2tXsovUzLdK7DVo1WyXJw1%40thread.tacv2/General?groupId=1fba625c-c9d1-40b7-bc22-19c8b3f97a1b&tenantId=f3308007-477c-4a70-8889-34611817c55a
http://www.ohio.edu/oit
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